
 

Maximizing the CC Read Only Role 
This guide helps you maximize your Read-Only Role to search the Harmony Data System (HDS) for 
important client information. We will explore different areas in HDS to demonstrate what you can see and 

understand what it means. 

Your previous instruction set helped you use your Read Only Role to verify your information in the HDS. 
Thank you for taking the time report your findings. We encourage you to periodically review your 
certification information and caseload in Harmony for accuracy during this transitionary period. 

 

This guide will review Harmony features: 

 Signing into SDS Harmony using a myAlaska login 

 Navigating My Harmony  

 How to locate a Consumer Record 

 How to read and filter Notes 

 

After this training you will be able to see when: 

 Applications have been received 

 Assessments are scheduled & completed 

 LOC Determination Notices are sent 

 LOC Letter  

 CAT report 

 Changes to Consumer Data have been processed 

 Plans have been reviewed and approved 

 Get copies of Approved Support Plans 

 

Includes a summary for: 

 Note types, Subtypes and what they mean 

 Filter to find specifics 

 Who to contact when you have questions 
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Navigating My Harmony  
The My Harmony page is the home page for entering the HDS. It provides a summary of information about consumers 
that you are linked to as a primary worker. From the My Harmony chapter page you can: 

 Search for your Consumer’s records 

 See Notes from SDS about your clients (consumers) 
 View your Ticklers list (reminders of upcoming deadlines) 

 See a breakdown of your consumer Program Status 

 See your Consumer List  
 View Assessment Appointments Scheduled 

 Review Inquiry information from previous requests to access Consumer records 

 
My Harmony summary page 

1. Header, Sign Out, Role, and File Menu Bar 
The top of your My Harmony screen is a fixed area that will display wherever you navigate to in the HDS. Key features 
include the Sign Out link, Role, and File Menu Bar. When you are within a consumer file, the individual’s name and HDS 
number are located within this area. The File Menu Bar is the area where you will go to take action. In your current Read 
Only Role you will not be able to save any actions you make. 

2. Quick Search and Advance Search 
The Quick Search allows you to change what area of HDS you are searching in quickly. The Advanced Search page is a 
precise tool for searching for a specific Consumer. Refer to the Introduction to SDS Harmony T01 Guide for more details 

3. Chapters 
The tabs located below the search bar are called Chapters. They each reflect a different area in Harmony. You can see 
what chapter you are in by the gold highlight. Below is a summary of each chapter in the HDS.  
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Chapter Definition 

My Harmony The home page that displays panels and queues of records in the system that are relevant to the current user, including notes 

to be read and a summary of the individual  CC’s  consumer caseload. 

Consumers Provides access to all consumers associated with CC agency, including individual CC caseload.   

Inquiry The system “front door” area to request access to a Consumer record in order to submit an application or represent a 
consumer. 

Providers The Provider chapter tracks certification and licensing credentials, ID numbers, workers, services offered, service areas, an d 

other types of provider information.  

4. Panels 

A summary of your information is located below the My Harmony chapter within Panels. The left hand column displays 
panels of summarized information related to Consumers assigned specifically to you. The right side, Inquiry column 
displays panels that summarize information on the people you have requested access to. Each panel contains one or 
more links with a count of related items. You can collapse or expand each panel to increase your visibility to relevant 
information by clicking the > in the top right corner of the panel.  

***When there is no information to display the panel will disappear, with the exception of Alert Notes.  

 

In the example below, there are 14 unread notes. 13 are “Completed” and one is “Pending”. The Notes will remain in 
this panel until you mark them as “read”. All notes are created and remain in the Consumers record, only notes that 
have you listed as a Note Recipient will show on this panel. If all the notes are marked as “read” the panel will disappear 
until a new note is received.  

 
My Harmony Consumer Notes 

 

Notes that are here usually means they are VERY important  

And you may need to do something about them ASAP! 

How to locate a Consumer Record 
There are many ways to locate a consumer’s record from your My Harmony Chapter: the My Consumers Panel and the 
Quick Search area are the most common. 

My Consumers Panel 
To view your consumer list, click the “Active” line in the My Consumers Panel on the My Harmony page. A new window 
will open  

  
Results from the My Harmony Consumer Panel: 



   
 9/20/2019 

Page 4 

 
Remember that you can sort any list by clicking the header box. Most lists have a predetermined sort order but you can 
change them to meet your current need. 

Quick Search 
Quick Search works best when you’re looking for a specific record and you have a search filter value, such as a 
Consumer’s Case No or Last Name. 

The Quick Search bar displays above the Chapter bar and contains three parts:  

1. Value  (Name or Number) 

2. Chapter (Consumers, Inquiry or Providers) 

3. Filter Field (Case No, Last Name, Medicaid ID) 

 

Quick Search Bar 

Bonus Info: If you would like to see a list of all the Clients served by your agency, go to the Consumers Chapter and do 
an unfiltered search.  

 Remember to clear any previous search results you just click the ADVANCED SEARCH link in the quick search 
area. 

Consumer Records 
A Consumer Record contains all the information about your client within organized tabs, such as their name and 
address, medications, diagnosis and their Certified Providers and Support Plan details. 

 Search for your consumer case records 

 View Assessment appoint Scheduled 
 Review information from Inquiries seeking access to Consumer records 



   
 9/20/2019 

Page 5 

 

Demographics 

In Harmony, a consumer record includes a demographics tab representing the person along with numerous other 
associated records for different types of information captured in different tabs.  

Division 

The Division tab is used to identify who is the primary worker (CC) or a secondary worker (PCA Admin). Sometimes you 
may see a SDS staffer as a worker.  

Programs 

The Programs tab associates a consumer with an SDS program. Each consumer will have at least one program record. 
“Combo clients” will have a separate program record for each program in which they are involved. Program history also 
displays here. For example, if a person was involved with the CCMC Waiver and then transitioned to the APDD Waiver, 
the past involvement in the CCMC Waiver program will continue to display as a program record that’s now closed.  

The Program status tracks a consumer’s stage in the program life cycle, as they move from application, to assessment, to 
planning, to authorization, and finally active or approved program involvement as a recipient.  

IDD/ISW will see what assessment cycle they are in next. A CC can look here to determine which reapplication type to 
prepare. 

 

Notes  

This is the most used area of the Consumer Record. Many important actions regarding a client’s services are 
documented through Notes.  Things that you should be able to locate in the consumers note’s tab: 

 Submitted Applications 

 When Applications have been determined complete 
o or returned as incomplete 

 LOC Determination Notices including the: 
o LOC Letter  
o CAT report 

 Changes to Consumer Data have been processed 
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 When Support Plans have been received  

 Get a copy of the Approved Plan 
 The Service Authorization number 

 Approved Amendments 
 Approved CFC Travel requests 

 Returned mail notices 

Forms 

The Forms tab allows users to view, edit, and add system created forms pertaining to a consumer.  
Some forms are very large, have complex configuration and can have data pulled into another area or report. The Plan 

Expedite and/or a Request for Safeguard Funding for ISW forms are completed in the Forms tab of a Consumer Record. 
Care Coordinators will complete Plan Forms within a Plan record such as the Plan Details form. 

Plans 

The Plans tab is used to track Person Centered Support Plans and PCA Service Plans. A Consumer will have a separate 
plan record for each plan period (year) and any amended plans. If the Consumer has a PCS and Waiver they’ll have a 
different plan for each.  

 The Plan Information page defines the Plan Program, Type, Status and Dates. 

 The Plan Forms page includes the forms for collecting additional details on the plan such as the Support Plan Details, 
and the Request for Visit Exception.  

 Service Goals are tracked under Needs-Goals.  

 The Planned Services subpage contains the services that are authorized within the plan.  

 Notes specific to this plan are added in the Plan Notes Sub-page (some of these Notes are also available through the 
Consumer Notes tab) 

  
Plan Information page 

Providers 

The Providers tab is used to track all certified Service Providers associated with the consumer. Once a provider is made 
‘Active’ on the consumer record, all system users assigned to that provider will have access to that consumer’s record. 
Closed Providers remain listed but no longer have access. 

Appointments 

The Appointments tab is used to track CAT Assessment appointments for the consumer. PCS Providers and Care 
Coordinators will receive an invite to the scheduled assessment. If you ‘Accept’ or ‘Tentatively Accept’ the appointment 
you will also receive updates if the appointment is changed. 
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Diagnosis 

The Diagnosis tab allows users to view the (ICD-10) associated with the consumer the SDS Harmony data system. This 
data is entered from the QDC or VOD sent each year. Open the record to view all diagnosis. (Only SDS Staff can add to 
this tab) 

Medications 

The Medications tab is used to record information on the medications prescribed to consumers. SDS Assessors will 
capture Medications during the CAT appointment but not all of the information about the medication. Once Care 
Coordinators are fully in the system, they will fill in all the details and add any additional medications when they are 
prescribed.  Information on discontinued medications remains but does not print on the Support Plan. 

Case and Professional Relations 

Harmony Relations tabs allows users to view, edit or add data for legal representatives and professional persons who 
are associated with the consumer.  

 The Case Relations tab is used to track legal representatives. (Only SDS Staff can add to this tab) Once the legal 
representative paperwork has been sent to SDS they will be added to the consumer record. You may see 
previous case relations or providers listed here. These can be removed by request when the Support Plan is 
submitted. 

 The Professional Relations tab is to document specific providers who are involved with consumer care such as 
Care Coordinators, PCA agency representatives, doctors, clinics, physical therapist, etc... Information located 
here is transferred to the CAT by the assessor. 

DD Eligibility 

The DD Registry tab provides the user with a quick view of the consumers place on the DD registry. Some Consumers 
may have an active ISW but still be in waiting status on the DD Registry.  

 This is only available for consumers who’ve entered the registry or updated their DDRR since January 2018 

 

 
 

 

Notes on the Consumer Record 
Notes are used to submit Applications, Support Plans, Changes of Status and for Provider Users (CC or PCS Admin), to 
receive approvals, authorizations and other communications from SDS about a specific consumer. A note allows the 
attachment of up to 10 files in PDF, Microsoft Word® or Microsoft Excel®, images in jpeg, gif and tif formats. 

What information can you locate in Consumer Notes? 
 Submitted Applications 
 When Applications have been determined complete 
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o or returned as incomplete 

 LOC Determination Notices including the: 
o LOC Letter  
o CAT report 

 Changes to Consumer Data have been processed 
 When Support Plans have been received  

 Get a copy of the Approved Plan 
 Service Authorization numbers 

 Approved Amendments 
 Approved CFC Travel requests 

 Returned Mail notices 

 

Notes that have been routed to you as a note recipient appear on the My Harmony Consumer section. They remain 
there until you ‘mark them as read’. The note will always be retained in the consumer’s record Notes tab.  

There are 2 types of Notes: 

1. Consumer notes located through the Notes Tab on the consumers record. 

2. Plan or Inquiry notes located through the subpage of the Plan or Inquiry record.  

a. Plan Notes appear in the consumer record’s Notes Tab even though they are created in the Plans Tab.  

b. Inquiry notes will be duplicated to the Consumer Notes Tab. 

 

When a Care Coordinator or PCS Admin has been specifically added as a Note Recipient there is generally an important 
reason. Think of this area as receiving a DSM to take care of something.  

Parts of a Note 
Each note includes several fields. The Note Type and a Note Sub-Type fields determine where a note is routed, so it’s 
important to select the correct options when you create a note. A table of Note and Sub-Types are listed in the 
Appendix of this guide. 

Note Type 

A Note Type describes the note’s main subject. A common Note Type example is Change of Status.  It is used to notify 
SDS of a change to a consumer status or records.   

Note Sub-Type 

The Note Sub-Type provides more detail about the note’s subject and helps to categorize it for routing.  For example, the 
Sub-Types for a Change of Status note include: Admission/Discharge, Demographic Information, Legal Representative, 
Cognitive Capacity/Service Model, and PCS Provider Transfer, Provider Discharge of Services / Closure, and Returned 
Mail Courtesy Notice. 

** There must be a sub-type selected in order for you to save a Note. Notes without sub-types are view only and 
cannot be created with the role you are using. 

Description 

The Description area appears in the list view of notes and is where you should enter a statement of the purpose of the 
Note. Only 270 characters fit in this field and it is a good place to enter a list of the documents that are attached.  

Note Body 

The body of the Note can be very large. It should contain more specific details that SDS or Providers should review when 
reading the note. The body of the Note can be added to by other readers until the note status is set to ‘complete.’ SDS 
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staff can change the status of the note to allow for more information to be added. This helps to keep all this information 
about an issue in one location. 

Note Attachments 

Attaching document files to a Note allows signed applications or plans and supportive documentation to be added to the 
consumer’s record.  An attachment can be any documentation that is in an electronic form, such as a letter created in 
Microsoft Word®, a PDF of a signed application, or a nurse’s handwritten note that has been scanned into another 
electronic format.  

Open a Note from the My Harmony page 
Notes are opened within the consumer record, or from your My Harmony Chapter. Notes that you are creating begin in 
a Draft status. Notes with a status set to Submitted are awaiting action from SDS- they are locked for any additional 
information. Notes that have been acted on by SDS are displayed as Complete are also locked.   

** You may see older Notes with a Pending status. They are the same as Draft status. 

1. To open an unread consumer note, from My Harmony, in the applicable section, click anywhere in the Complete 
row. 

*If you do not have any unread Notes you will not see this Panel on your My Harmony page. 

 
Consumer Notes 

2. A list of notes is displayed. To open one of the notes, click anywhere in the note’s row.  

 

List of Notes 

3. The Note is displayed. This note is located in the consumer’s record this is just a direct link to it. 
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Note Details 

4. You may open, save and print any attachments to the note. 

 
List of Note Attachments 

5. To close the note, click File – Close Notes.   

Mark a Note as Read  
Notes specifically routed to you will appear in the My Harmony > Notes panel and will continue to display there until 
you manually mark the Note as “Read.” 

Once you are done with a Note, you may ‘Mark as Read’ from the Tools menu to remove it from the Unread 
Notes panel. This does not removed it from the consumer’s record. 

1. Check the box at the end of the Note line when ready to delete it from this list 
2. Go to the Tools menu 
3. Click Mark as Read 
4. Notes that were checked will be deleted when the My Harmony screen refreshes 
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Filtering a list of Notes 

Any list view of records can be narrowed for specific information using the Filters area. The following are helpful filters 
to locate specific types of information: 

 
List of Notes from the Consumer Notes Tab 

Note Type Filter  

This filter will help you locate a specific Note Type. All the results will include the Notes with that specific Note Type.  
You can narrow your search by adding an additional filter of Note Sub-Type, click the green plus to add as many filters as 
you need. This will requires you to know the right subtype (in this case approved) and have the item listed.  
 

This is an example of finding an IDD LOC Determination.   

 NFLOC determined waivers use Note Sub-Type ‘Notice Sent-Approval’ 

 

Filter for Attachments 

This filter is helpful for finding Notes with attachments. These usually contain: 

 LOC Letters 
 CAT Reports 

 Approved Support Plans 
 Applications 

 Documents that have been mailed to your consumer 
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Assessment Appointments 
The Appointments tab is used to track CAT Assessment appointments for the consumer. Care Coordinators and PCS 
Providers will receive an invite to the scheduled assessment. If you ‘Accept’ or ‘Tentatively Accept’ the appointment you 
will also receive updates if the appointment is changed. You will be alerted to a new appointment when the 
Appointments panel appears on your My Harmony page. It appears under the My Consumers panel.  

 
1. Click to open the Scheduled assessment.  

 
2. Got to the flyout menu at the far right of the appointment line and select ‘Accept’ or ‘Tentatively Accept’. If 

you choose to ‘Decline’ the appointment you will not receive any updates if the appointment date or time 
changes. 

 
3. Once the Appointment has been accepted it disappears from your My Harmony page. It is still listed in the 

consumer’s record. So make sure you transfer the information to your personal schedule 
 

4. If there are no assessment appointments that you’ve been invited to, there will be no Appointments panel.  
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Ticklers 
A tickler is a reminder to do something, such as complete a form for a consumer. Harmony creates ticklers automatically 
based on specific system triggers. You should review your Ticklers daily, but do not rely on them to let you know when 
something is due.  You are required to maintain your own record keeping system as part of your Condit ions of 
Participation. 

SDS began using the SDS Harmony Data System (HDS) in January 2018, Ticklers have been generating since then. After 
the launch of the HDS many configuration changes have happened, therefore many ticklers are irrelevant now or have 
been updated to be more helpful. Additionally many ticklers due dates have long passed. 

 
That’s a lot of Reminders!!! 

It is OK to cancel or complete these. 

Prior to deleting any Tickler you should check your own records to verify the action has been completed.  

Using Ticklers Daily– 
The HDS creates ticklers automatically. You may receive several ticklers throughout the day, so it is important to check 
often for new ones. 

Sorting List Views 

List View screens allow you to quickly retrieve a desired record.  If the desired record is not displayed on the initial list 
view, you can click on one of the buttons at the below the list to scroll through the returned records. 

All HDS data that is displayed in a List View can be sorted by ascending or descending order by clicking on the column 
headers in the list view. 

You can also modify the number of records returned in the List View by entering the desired number in the “Retrieve 
[15] records at a time” field at the bottom of the screen and then clicking on one of the record search buttons (i.e., First, 
Previous, Next, Last). 

  
 

Act on a Tickler 

When you open a Tickler that has an associated action in the HDS it may take you directly to that action point in the 
consumer’s record. For example we clicked on the Tickler named “LOC is Approved, Begin working on the Plan” and the 
system took us to the consumer’s record> plans tab. 
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We can clearly see that the Support Plan from this Tickler that was dated 1/19/18 has already been submitted. So it can 
be marked ‘Complete’ by using the flyout menu available in the Workflow Wizard task area.  Then using the File menu 
select Close the Workflow Wizard. 

  
 

When opened some Ticklers just show you a message that repeats the Tickler Name like this: 

 
 

Use the flyout menu at the end of the tickler line to ‘Cancel’ or ‘Complete’ when you no longer need the reminder. 

 
Managing your ticklers should help you to manage your work load but DO NOT rely on them to direct your tasks all the 
time. You must maintain your own client management tools in order to meet regulatory deadlines. If you receive a 
transfer client close to when their reapplication or renewal Plan is due you may not receive the ticker. Therefore you will 
be late. 

Dismissing Ticklers 

1. To start open your Ticklers list, then click on the ‘Date Due’ twice to sort them by the oldest due date. 

 
2. Open the Flyout menu by hovering your mouse pointer over the triangle on the far right of the tickler line. The 

action menu for this specific tickler will appear. Possible actions can include: 

 Cancel   
 Reassign -only send a task to someone who also has access to this consumer 

 Edit 
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 Complete 

 View Consumers Record -use to verify you have already completed the task 
3. Select either ‘Cancel’ or ‘Complete’ to remove the Tickler from your list. SDS does not track what you do with 

your ticklers. They are there simply to remind you something may need to be done or let you know that 
something (like a LOC or Support Plan) has been approved or completed.  

 

View Future Ticklers 
If you are looking for ticklers that have a due date in the future, uncheck the Apply Alert Days Before Due and click 
Search. The list view page will refresh and present a list of the ticklers and their due dates.  

 

 

Apply Alert Days Before Due tickler list view 

 

My Consumer Programs 
The largest panel on your My Harmony page is likely to be My Consumer Programs. Many of our clients have multiple 
programs; PCS and a Waiver for example. Some of our clients have previously applied for or received services from other 
SDS programs; CCMC to APDD for example and that history is included in their Consumer Record. Therefore your My 
Consumer Programs total count will not the same as your My Consumers count. 

There are over 45 program statuses available in the SDS Harmony Data System. Ranging from ‘Act ive’ to ‘Suspend’. Most 
of them are self-explanatory and none of them require a Care Coordinator to take an action. They are available for your 
information and to provide transparency to the life cycle of the consumer’s program status. 

 

Some of the most common Program Statuses a Care coordinator may see are: 

 Request Application   
 Assessment Requested  

 Assessor Assigned 
 Assessment Scheduled -There should also be a corresponding Appointment reminder 

 Assessment QC 
 Assessment Scoring 

 LOC/LOS Determined -There should be tickler to begin this person’s initial Support Plan 
 Active 

 Suspend  -SDS is awaiting a determination of some type. Medicaid, LTC, Incarceration etc...  
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You can open the Consumer’s Program Tab to see reasons why a program was Expedited, Suspended or Closed. 
Sometimes there are additional comments about why a program is in a specific Status.  

 

Care Coordinators should review this information often to see if one of their consumer’s programs has unexpectedly 
changed. This could be an indicator that something needs to be looked into. For example if SDS sends a registered letter 
and it comes back undeliverable, the program may be put into ‘Suspend’ status. The CC could then get in contact with 
the client, deliver the important information and verify any address changes. 

How to Locate…  

A List of Specific Providers  

Care Coordinators often need to locate certified providers of service in specific areas of the state. Sometimes you just 
need to find the Medicaid ID # for a certified provider.  

1. Go to the Providers Chapter 
2. Click the Advanced Search Link 
3. The Reports menu should appear next to the File menu 

 
4. Select the Certified Provider Search Tool from the Reports menu 
5. Set your report perimeters 

a. Select the certified services  
b. The Boroughs you are looking for providers in 
c. What SDS programs the provider is certified to serve 

6. Click the View Report button in the upper right corner. 

7. You can download the report in a variety of formats by selecting this icon  
a. To create an Excel document that can be sorted, select the CSV format  
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The Most Recent LOC Determination 

There is no data field in the Consumer Record that records the current LOC dates for the consumer. The LOC 
determination and its supporting documents are located in the Note tab of the consumer’s record. 

1. Open the Consumer’s Record 
2. Open the Notes Tab 
3. Filter the Notes by clicking the green plus sign to open the Filters  

   
4. Set to Note Type to “LOC Determination” and click Search 

 
Notes should automatically list newest to oldest- some notes prior to 2019 may look odd 

 
***For NFLOC determinations look for note Sub-type ‘Notice Sent-Approval’ 

 

A Current Authorized Plan 
1. Open the Consumer’s Record 
2. Open the Plans Tab 
3. Open the most current Plan with the Status of ‘Approved’ 
4. Go to the Plan Notes Sub-Page 

 
5. Locate the Note Type Plan Note with Note Sub-type Planned Services Approved or Plan Attachments 

ALI Plans 

 

IDD Plans 
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6. Once the Note is opened, the approved Plan can be saved to your files and printed as needed.  

The Current Service Auth # 
There is no data field in the Consumer Record that records the current Service Authorization (SA) # for the consumer. 
The SA# and any supporting documents are located in the Notes tab of the consumer’s record. 

1. Open the Consumer’s Record 
2. Open the Notes Tab 
3. Filter the Notes by clicking the green plus sign to open the Filters.  

   
7. Set to Note Type to “Auth Change” and click search 

 
All of the Authorizations created since 2018 will be shown, this will capture any changes to the SA that may have 
occurred due to various reasons i.e. Amendments, Mediations or Fair Hearing.  
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Your Certification (credential) Dates 

Your renewal certification application is due to SDS no later than 60 days before the expiration of the current 
certification. It’s important to track this information so you can meet all the training requirements in a timely fashion. 

 

1. From the My Harmony page select the “Providers” chapter.  
2. Click ADVANCED SEARCH in the Quick Search area to clear your previous results. (if needed) 
3. Within the Advanced Search field select the “Search” button. Leave all fields blank to pull all providers you are 

affiliated with. 

 
4. Now select your Individual Care Coordination Record 

 
5. Open the Credentials tab 

 
6. Current and past certification dates will be listed 

 
 

 

  



   
 9/20/2019 

Page 20 

Who do you contact for Questions? 

Where to find something? 

The SDS training team is here to help you navigate the system and get more comfortable exploring it!  

Senior & Disabilities Services Training Team: 

Kara Thrasher - Livingston – Training Specialist III  (907) 269-3685 
Kara.Thrasher-Livingston@alaska.gov,   
Cina Fisher – Training Specialist II (907) 269-3734  

Cina.Fisher@alaska.gov,  
Delight Mells – Training Specialist I (907) 269-3672 

Delight.Mells@alaska.gov,  
Cassandra Lynch – Health Program Associate, Training  (907) 269-3448 

Cassandra.Lynch@alaska.gov,  

 

Is it broken? 

Please let our DSDS Harmony Help team know if something doesn’t seem right with the system. Examples include:  

 unable to login (account is deactivated),  
 difficulty loading pages,  

 slow search results speeds,  
 other functional issues  

 

Contact via email: dsdsharmonyhelp@alaska.gov no HIPAA data please 

 OR DSM to: "HarmonyProviderHelp, DSDS" <dsds.mcelp@hss.soa.directak.net> 

 

 

An attachment is missing or I have a case related question. 

Contact either the IDD or NFLOC unit about case related information or if you believe an attachment is missing. 
Harmony does not function like an email system so it is critical that you keep your DSM account to communicate about 
your clients and comply with HIPAA. 

Contact the unit if you are missing a consumer or suddenly see one and they are not familiar to you.  

 

IDD Unit’s DSM sds.iddAnchorage@hss.soa.directak.net 

NFLOC Unit’s DSM dsds.nflocwaiver@hss.soa.directak.net 
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